04 - Charts

1. Chart Types and Dimensions

Types
Pie — view what part data is when compared to the whole

2010 Enrollment, Saratoga Springs City School District,
Elementary Schools

= Caroline Street Elementary School
= Division Street Elementary School
u Dorothy Nolan Elementary School
= Geyser Road Elementary School

= Greenfield Elementary School

= Lake Avenue Elementary School

Bar or Column — view data over a series (usually time)

Total Energy Consumption, 1949 - 2008
(billion btu)

150,000,000

100,000,000
o H ‘} H “ H

nnnHlHHHHH | H H

Q‘m
cnm
—

1949
1974
1979
1984
1989
1994
1999
2004

1954
1959

Chart Dimensions
You can alter a chart’s dimensions using the same techniques that we used with images in the

Formatting topic (Topic 2). You can move and resize them, drag the corner points (to resize and
maintain the aspect ratio), drag the mid points (to resize and distort the aspect ratio)

Example Data and Corresponding Charts
Data set examples — what is the appropriate chart type?

Superbowl score difference over years
Student score distribution
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Qil price changes
Racial breakdown — City of Saratoga Springs

2. Creating a Chart
2.1 Create a Pie Chart — use the

Excel file

(1) Select the data that will be the subject of the chart

&
SCHOOL

Caroline Street Elementary School

Division Street Elementary School

Dorothy Molan Elementary School

Geyser Road Elementary School

Greenfield Elementary School

Lake Avenue Elementary School

e R BT, ST R U

(2a) On the Insert Tab/Charts group — choose one of the pie charts

IMSERT PAGE LAYOUT FORMULAS DATA REVIEW WIEW DEVELOPER
n | ] - ’ = ai-&-%- Ja
E? IJ;] DEH’EI L 17 - - i Nz
PivotTable Recommended Table  Pictures Online Apps for  Recommended PreotChart
PivotTahles Pictures &3+ 7 Office~ Charts "" b - -
Tables Ilustrations Apps 2-D Pie
B2 - J || 475 I.-f"];\.l .-"_'Q' o .@
Ly GO &
A B C |
1 SCHOOL STUDENTS | FULL TIME CERTIFIED TEZ 3D Fie
2 |Caroline 5treet Elementary School 475 31 e
3 |Division Street Elementary School 419 27 E\;'ﬂ
4 |Dorothy Molan Elementary School 893 60
5 |Geyser Road Elementary School 432 30 Ll
6 |Greenfield Elementary School 438 29 Pr
7 |Lake Avenue Elementary School 465 30 "-\'}_-:-j',fl
8
g B Mare Pie Charts...
10

Po
Wi
Ref




(2b) Or choose Pie from the Charts tab of the Quick Analysis tool.

Column

Bar

Recommended Charts help you visualize data.

ENTary SChool a8 2
=mentary School 465 | 30
FORMATTIMNG CHARTS TOTALS TAEBLES SPARKLIMES
° e 2 !’--D [
o I
mm & K L2 O 1%
Clustered Clustered Line Scatter Pie More
Charts

2.2 Create a Column Chart - use the energy consumption.xlsx Excel file

Make a Total column to use for the data for the chart

[

A

=SUMDEEY

'
{ Table 2 1a Energy Consumption by Sector, 1935 2004 (Bifkon Stu)

3 Year Revdentiol ] Yot

4 l 1My 3,004,008 4,870,240 14,716,703 lmoamy b . L3040

- —

" 1560 3,995,210 395,068 16.232 375 3492504 . wde ot s ol aetern ta w rennge thet Ses adibtamnal muerisers adiscert 13 it
1 8,307,324 1AL 17,800,254 0,042,102 ! i |
1552 4,567,703 1375363 17,300.375 3,003 0% | @R RD|
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(1) Select the data that will be the subject of the chart and click on the Quick Analysis button.
(Or, on the Insert Tab/Charts group — choose one of the column charts.)

i Total
31,951,665
34615, 747
36,973,843
36,747,743
37,564,506
36,633,251
40,207,341
41,754 427
4178731
41,645,017
435,465,753

45 056,864
45,733,122

47,527,747

43 546,057
51,817,315
Sd, 007,100
g;g?ﬂzﬂ Quick Analysis (Ctrl+Q)

2,413,155 Use the Quick Analysis tool to
B5.621.157 quickly and easily analyze your data
E7.544.040 with some of Excel's most useful

B3.283.272 tools, such as charts, color-coding
72,704,343 and formulas.

75,701,023
73,363,775
71,395,551

75,004,760 | = | e

F7 997 1RE

AVERAGE: 71,371,217 COUNT: 80 SUM: 4,282,2




(2) Choose Clustered Column from the Charts tab of the Quick Analysis tool

al

33
=
3
75
BB |
42
23]
56
F30]
71
7]
k24
Faz]
0EL

120,000 000

100,000 000

20,000,000

S0, 000,00

ChartT

210 000,01 R0
a

1237 9113187192150 7 293] 335857 3941434347 453133 3337 39

itle

1 FE = =TT

I aocac

Eil
Tt
34
=
)
A7
£
26
7
rGd
516
7l

FORMATTIMG

CHARTS TOTALS TABLES SPARKLIMES

< B i

Line Scatter  Clustered

Recommended Charts help you visualize data.

Colurmn

Clustered Mare
Bar Charts

B

15,243,706

71935551

42

13,033,351

75,004,760

=]

159 245 E24

77 9497 13E

B

3. Chart Parts

3.1 Identifying and Modifying Chart Parts

Rest mouse over a chart part to see that
chart part’s name

Right click a chart part to modify it

AVERAGE: 71,371 217 COUNT: 80 SUM: 4,252,
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Choose Format (chart part) to show
formatting options

3.2 Modifying the Legend on a Pie Chart

Delete
=] Resetto Match Style

Font...

11 Change Chart Type..

Select Data...
3 3-D Retation...

dﬁ Format Legend...

il m5 l%
— 2
= legend
Fill  Cutline

(1) Right click on the Legend, choose Select Data...

it

&

Legend -

Fill  Cutline

=1 =

Delete

189 Resetto Match Style

" A Font.

11 Change Chart Type...

Select Data... f—

3 3-D Rotation...

|}i‘, Format Legend...
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(2) This shows the Select Data Source dialog box. Click the Edit button over the Horizontal

(Category) Axis Labels list box.

Select Data Source -

Chart data range: | =5heet!SB52:5657|

f}"—l ’ @ Switch Row/Column ] I—‘“{l

Legend Entries [(Series) Haorizontal (Category) Axis Labels

[ Bae0 || Do [ xamon ] - |- | [[Goon ]

Seriesl

HEEEE

1
2
3
4
5

m

| Hidden and Empty Cells

(3) This shows the Axis Labels dialog box.

Asis Labels L2 [

Axis label range:

Select Range

| ok || cancal

| ok || cancal
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(4) Use this to select the range of cells that have the desired contents for the legend and click
the OK button.

A B C D E

1 SCHOOL STUDENTS | FULLTIME CERTIFIED TEACHERS

2 [Caroline Street Elementary School i 475 31

3 |Division Street Elementary School | 419 . - : :
| fuis Labels P [

4 )Dorothy Molan Elementary Schoal | 893

5 IGeyser Road Elementary School i 432 Axis label range:

6 |Greenfield Elementary School | 428 —Sheet2!SAS2:5A57 = Caroline Stree...
I

7 |ake Avenue Elementary School __ |1 465 ok | [ canca

8

9

10

(5) The new legend contents show in the Horizontal (Category) Axis Labels list box.

7 {I?

| Haorizontal (Category) Axis Labels
[ £ Edit ]

B Caroline 5treet Elementary 5chool e
Division Street Elementary School
Dorothy Molan Elementary School 3
Geyser Road Elementary S5chool
Greenfield Elementary School -

OK ] [ Cancel




(6) You can resize chart parts the same way you resize images — by using the corner and/or mid-

point drag handles

Chart Title

Caroline 5t mentary
Schoal

m Division 3treet Hementary
School

= Dorgthy Molan Elementary

School
[m] [m]
Geyser Road Elementary School

n igreenfield Elementary School

= Lake Avenue Bementary School

[, . |

Example of a resized legend

= Caroline Street Blementary School
m Division Street Bementary School
m Dorothy Molan Elementary School
m Geyser Road Elementary School

m reenfield Elementary School

m Lake Avenue Elementary School
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3.3 Modifying the Horizontal Axis Labels on a Bar Chart

(1) Right click on the Legend, choose Select Data...

=

Delete
23] FReset to Match Style
Font...

Change Chart Type...

il
Select Data... ~fff—

Add Major Gridlines
Add Minor Gridlines

a
Ii 23 &4 3B 785 9100117131433 06171819 202122233 24232627 R S UL SF 3939 30 90 37 W IS0 G1 G S5 S5 00 45 47 48 43 7

1}4 Format Axis...

& Z
= Horizontal (Cal -

Fill  Outline

(2) This shows the Select Data Source dialog box. Click the Edit button over the Horizontal

(Category) Axis Labels list box.

* ® )

Select Data Source

-
Chart data range: | =Sheet2!SF54:5F363] 35
fj—l ’ @ Switch Row/Column I—“{I
Legend Entries [(Series) . Haorizontal (Category) Axis Labels
E T R T —
Seriesl <
E

9 E E EE

1
2
3
4
5

-

Hidden and Empty Cells

| ok || cancel |
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(3) This shows the Axis Labels dialog box.

(4) Use this to select the range of cells that have the desired contents for the legend and click

the OK button.

o, E C O E
1 | Table 2.1a Energu Consumption by Sectar, 1343-2003 (Billion Btw)
2
L e : ' o
+ 1343 H Axis Labels
5 | 1550 !

-

& i 1351 ! Axis label range:
T 1352 ]
51 T ! = Sheet2!SAS4:5A563 - 1949, 1950, 19..
g 15954 ]
s L= E | ok || Ccancel
o 1356 H
2 | 1357 1 T22) .363, 204, :
3] 1355 i 5.211515 4,122,035 13,306,571 10,004
" 1959 ! 5424515 4,375 6239 20,315,979 10,345
5 | 1560 i 3053445 4 13,134 20,625,424 70,595

(5) The new legend contents show in the Horizontal (Category) Axis Labels list box.

>
Select Data Source

Chart data range:  =Sheet2!SAS4:5AS63,Sheet2!SFS4:5FS63 g‘i
, ‘i [Sﬂit(h Row/Cqumn] : | |
Legend Entries (Series) Horizontal (Category) Axis Labels
{ £ Add ][ I Edit ][x:_zemove] alw [ 7 edit |
V| Series1 ¥ 1949 fa
] 1950 =]
] 1951
[ 1952
[¥] 1953 -
| Hidden and Empty Cells | | ok || cancl




(6) Now the year labels display in the horizontal axis of the bar chart

oy e B I e O T Y W e Y O v T e T o I = T IR X
e L T T T T T O T O T T W T T W T Y T I W IR R
v G o Oy G G O h O O O O O
s s = = w4 v s = =4 =34 =4 =4 4 w4 4 = i =

(7) You can make additional modifications to the axis labels — right click on the axis labels and
choose Format Axis...

1984

1989

S

19¢

Format Axis X

AXIS OPTIONS ¥  TEXT OPTIONS

SO oE ol —-—

() At maximurn category [«]
Axis position

() On tick marks

(® Between tick marks

[ Categories in reverse order

» TICK MARKS ]
4 |ABELS

Interval between labels

() Automatic

# Specify

: -
~ interval unit _

Distance from axis 100|
Label Position Mext to Axis =

For example — you can set the interval between labels - Click on the axis options button (top red

arrow in the above image) and specify the interval unit in the Labels group of the format axis

tools.
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3.4 Some Other Chart Parts

Chart Area - You can modify the background fill color

Chart Area
eet Hementary achoo

Eet Bementary School

lan Elementans School

Plot Area - You can modify the background fill color

(w0 O

S 1

Chart Title

Chart Title
Chart Title

Axes — Horizontal and Vertical

I3 13 47 19 I I3 I3 7 X9 31 33 33 37 39 4 B0.,000,000

60,000,000

[ Horizental (Category) Axis h

=0.000 Vertical (Value) Axis

20,000,000

© 2014 Saratoga Software

Page 13



Axis Title

Axis Title

27 29 31 33 35 37 329 41 43 45 47

Horizontal (Category) Axis Title }

Data Labels

m Geyser Road Elementary School

m Greenfield Elementary Schoal

m Lake Avenue Elementary School

Series 1 Point "Dorothy Molan Elernentary School” Data Label l

Gridlines
HE  Grdlines b
ﬁ Prirnary Major Herizontal
|:|:| Legend k
g Lines M Primary Major Vertical
|2 Trendline 3
[e4  Up/Down Bars E Primary Minor Horizontal

il

Prirnary Minor Vertical

Meore Gridline Options..

3.5 Adding Other Chart Parts

If they are not displayed on the chart, you can add additional chart parts. Click on the chart to
select it, then click on the Design tab of the Chart Tools part of the ribbon.

|
CHART TOOLS

DESIGM FORMAT
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Then Add Chart Element

HOME

1k
Add Chart ick
Elernent = Layout -

Chart Layouts

Choose the chart part to add

= -
FILE HOME It
e
Add Chart Quick Cha
Element = Layout~ Colg
iMh Axes C
Idh  Axis Titles 3
dh  Chart Title 3
i Data Labels P
Idh, Ciata Table L.
il  Error Bars .l
ik Gridlines » :
|:|]:| Legend k :
| Trendline y
" ] |

4. Stacked Column Chart - Combination of Pie and Column charts

A stacked column chart is a combination of a bar chart and a pie chart. It shows the overall change over
a series, and also shows the portion of each part over that series. For example, in the data below, the
total energy consumption is the sum of the residential, commercial, industrial, and transportation
consumption components. A stacked column shows the total energy consumption over the years, and
also the portion of each energy consumption sector over the years.



A B C ] E

1 |Table 2.1a Energy Consumption by Sector, 1949-2008 (Billion Btu)

2

3 Year Residential Commercial Industrial Transportation

4 1998 18,986,464 16,013,536 34,926,384 25,255,455

5 1999 19,582,928 16,421,544 34,853,627 25,948,049

6 2000 20,445,761 17,218,069 34,755,525 26,548,003

7 2001 20,064,807 17,179,872 32,802,793 26,274,814

8 2002 20,837,794 17,404,375 32,762,390 26,844,037

9 2003 21,138,904 17,387,615 32,612,018 26,993,593

10 2004 21,124,816 17,707,110 33,591,933 27,894,875

11 2005 21,659,926 17,905,328 32,527,701 28,351,927

12 2006 20,734,770 17,760,105 32,466,383 28,828,760

13 2007 21,599,692 18,313,720 32,498,949 29,117,985

14 2008 21,606,384 18,411,218 31,357,561 28,026,827

To create a stacked column chart —
(1) select that data for the subject of the chart
& D

1 |Table 2.1a Energy Consumption by Sector, 1949-2008 (Billion Btu)
2
3 Year ﬁg;iggmm ngmg[;m |WH§I[W| [dosporiation
4 1998 18,986,464 16,013,536 34,926,384 25,255,455
5 19935 19,582,928 16,421,544 34,853,627 25,948,049
6 2000 20,445,761 17,218,069 34,755,525 26,548,003
7 2001 20,064,807 17,179,872 32,802,793 26,274,814
8 2002 20,837,794 17,404,375 32,762,390 26,844,037
9 2003 21,138,904 17,387,615 32,612,018 26,993,593
10 2004 21,124,816 17,707,110 33,591,933 27,894,875
11 2005 21,659,926 17,905,328 32,527,701 28,351,927
12 2006 20,734,770 17,760,105 32,466,383 28,828,760
13 2007 21,599,692 18,313,720 32,498,949 29,117,985
14 2008 21,606,384 18,411,218 31,357,561 28,026,827




(2) Insert the Stacked Column chart using the Quick Analysis button or from the Insert tab of the
ribbon (as shown in the image below)

DATA REVIEW WIEW DEVELOPER

= T=C - ) i i = =
I ? Li ﬁ' (B2 Ig _M . "' -Y Y
: 2-D Col i
Recommended s 'ower Line Column Win/ Slicer Timeline
Charts View Loss
’—HH_‘ |:| H |:| H eports Sparklines Filters
3-D Column Stacked Column

Use this chart type to: -
D = Compare parts of a whole, J K
Btu} » Show how parts of a whole

change over time.

ustrial | Tr hﬂl[ﬂ]l ] ' :

Title

Ikl Mere Column Charts...

120,000,000

100,000,000

£0,000,000
60,000,000
40,000,000
20,000,000
0

1 2 3 4 5 & 7 8 9 10

mSeries]l mSeries? mSeries3 mSeriesd

11
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Add labels to the legend following the instructions in the (3.3 Modifying the Horizontal Axis
Labels on a Bar Chart) section above.

gapepanm

et LARRLTAERT]

Finished Stacked Column chart.

120,000,000
100,000,000
80,000,000
60,000,000
40,000,000
20,000,000
0

Energy Consumption by Sector, 1998 - 2008

1998 1999

H Residential

2000

2001

B Commercial

2002 2003

M Industrial

2004

2005

W Transportation

2006

Ch =tHEHEEH AR = =
Cclac:'?E = s Select Data Source
Chart Styles Chart data range: |
- £ 18986464 | | The data range is too complex to be displayed. If a new range is se|
| | Series panel.
B C D E '(}’ |:;::~?:.. Co
rgy Consumption by Sector, 1949-2008 (Billion Btu) Legend Entries (Series] R—
— : —
Add > Edit Remave B v B3 Ed
Residential Commercial Industrial Transportation ’ =4 ” e ” B l |_| ’ i
18,986,464 16,013,536 34,926,384 25,255,455 Residential 198
19,582,928 16,421,544 34,853,627 25,948,049 Commercial 19
20,445,761 17,218,069 34,755,525 26,548,003 Industrial 20
20,064,807 17,179,872 32,802,793 26,274,814 Series4 20
20,837,794 17,404,375 32,762,390 26,844,037 20
21,138,904 17,387,615 32,612,018 26,993,593
21,124,816 17,707,110 33,591,933 27,894,875 |_Hidden and Empty Cells |
21,659,926 17,905,328 32,527,701 28,351,927 —
0 TF2A TTIN 17 TaN 1N 27 ARR 200 29 970 TFEN 20'000'000

2007 2008
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5. Using charts in other (including Office) applications

You can easily include an Excel chart to other applications — like Word or PowerPoint.

Follow these steps:
1. Select the chart in Excel and copy it to the clipboard (right click and choose copy from the
pop-up menu or click on copy on the xxx tab /xxx in the xxx group on the ribbon). Make sure you
have the entire chart selected (the corner and mid-point drag handles are showing) and not a

just chart part.

2. Open the file that will be the destination for the copied Excel chart. This example uses a
Word document.

3. Position the Insertion Point in the location that you want to paste the chart.

= Lorermn Ipsum Text.docx [Compatibility Mode] - Word
INSERT DESIGN PAGE LAYOUT REFEREMCES MAILINGS REVIEW VIEW
ibri - - A A - A e e T TR —
Calibri (Body) - |11 A A Aa =R R AT | AaBbCcDc AaBbCeDe AaBbC  AaBbCcl Aatj AaBbCcC
- B I U ~ab x, X . A =E=E== 1=- TMormal = Tho Spac.. Headingl  Heading 2 Title Subtitle
] Font [F} Paragraph ] Styles
1 E 1 2 3 4 5 3 A 7

Lorem-lpsum-Text
1
Lorem-ipsum-deolor-sit-amet, consectetuer-adipiscing-elit.-Nam-cursus.-Morbi-ut-mi.-Nullam-enim-lec,
egestas-id,-condimentum-at,-laoreet-mattis,-massa.-Sed-eleifend-nonummy-diam.-Praesent-mauris-ante, -
elementum-et,-bibendum-at,-posuere-sit-amet, -nibh.-Duis-tincidunt-lectus-guis-duiviverra-vestibulum.-
51 disse-vulputate-ali

dui.-Nulla-elementum-dui-ut-augue.-Aliguam-vehicula-mi-at-mauris.-

Maecenas-placerat,-nisl-at-consequat-rhoncus,-sem-nunc-gravida-justo,-quis-eleifend-arcu-velit-guis-lacus -
Morbi-magna-magna,-tincidunt-a,-mattis-non,-imperdietvitae, tellus -Sed-odio-est,-auctor-ac,-sollicitudin-
in,-consequat-vitae,-orci.-Fusce-id-felis.Vivamus-sollicitudin-metus-eget-eros.q

1

Pellentesque-habitant-morbitristigue-senectus-et-netus-et-malesuada-fames-ac-turpis-egestas.-In-
posuere-felis-nec-tortor.-Pellentesque-faucibus.-Ut-accumsan-ultricies-elit.-Maecenas-at-justo-id-velit-
placerat-molestie.-Donec-dictum-lect us-non-odio*:ra s-g-ante-vitae-enim-iaculis-aliquam.-Mauris-nunc-
guam,-venenatis-nec,-euismod-sit-amet,-egestas-placerat, -est.-Pellentesque-habitant-morbi-tristique-

senectus-et-netus-et-malesuada-fames-ac-turpis-eg .-Cras-id-elit.-Integer-guis-urna.-Ut-ante-enim,-
dapibus-malesuada,fringilla-eu,-condimentum-guis,tellus.-Aenean-porttitor-eros-vel-dolor -Donec-
convallis-pede-venenatis-nibh.-Duis-quam.-Nam-eget-lacus.-Aliqguam-erat-volutpat.-Quisque-dignissim-
congue-leo.q

1
Mauris-vellacus-vitae-felis-vestibulum-volutpat.-Etiam-est-nunc,-venenatis-in, tristique-eu, -imperdiet-ac,-
nisl.-Cum-sociis-natoque-penatibus-et-magnis-dis-parturient- montes,-nascetur-ridiculus-mus.-In-iaculis-
facilisis-massa.-Etiam-eu-urna.-5ed-porta.-Suspendisse-geam-leo, molestie-sed, -luctus-guis, feugiat-in,-

pede.-Fusce-tellus -Sed-metus-augue, -convallis-et,-vehicula-ut,-pulvinar-eu, -ante.-Integer-orci-tellus, -




4. Paste the chart into the document (right click and choose Paste from the pop-up menu or
Paste from the ribbon.

BE % 0: Lowen Tpsarn Tesk Sors | Compabindty Minde] - Wosd TH - 02
oM T DESGN  PAGE LAYOUT FEFERERACEY [RTVE 5 g S ww Sgrm ”
e ¥ o Y v o 4y e -+ . N -
vl o X s Bl EdtEeSEe = 4 . 3} "
Comoloayt [} - K K Ma- B E i FE S amnceor] asmceon AaBC awbce AQD asswcer |
- ¢ o % ¢
Paite * ° r =R B D . T Poateen The & ST [t T e
™ S rarin & T U A YA B e e B Ml o kgt Heatgd  Tow S ] gy
bptisaitt 3 Pt 3 Paagragh . e G tenrg ~
. | 1 1 ‘ i . '
Meee o clezerat, riul ot Corsezuwt thatcue, sBT ruse gredte Anto Quit < etierd ercu st o iecus
NIOHE gl ), dncSustla, el ndn, tmperdiet viae, 1ol Sed-odo et Sather ag solhutudn
i, coraegust vitee orzl Susce ol fabe Vivarue sebciudis metus aget oo €
L]
Potlantpsgin habstam Orti e s seractiug «f (rts o8 maletunds fare) 60 1D S08T 9
DOtes e STk NeC e Selerneiaue Sulbul LB ScUsAn Uricies skt Msacans it juato o vebt
placenst meleitie Donec sictum lectes cor ol
Sarstoge Sovings Demnentary Sthools
* Crwme Pret Tnenv ey S
" o Temm b aw Vo g Y-
* Ty Ve Dty Sy
e e b mrad ey e
o+ Drvwrhent Tamws e ay
Py S R -
[Orart A
Crusw arts s Ran
e acds s hauam MauE MRS QUE, vEneTetit aac aumod oF arret agaitad ¢ ) (i
Pelierizazue beirtart marts irtrtoue sereshu ol et ot maleisde fame oc trn s egetas. Craad
alt mteger Quts wrna LR erte enim, deslue L freghtis eu, Qan talia Asvean
Partinee e108 vl dodor. Sonec corval bl pede vaneratss =% Duescuam Nam epet lacus. Absuen o
»olatiy Qedzqee dgnssn congoeien d —

5. (Charts in Word) Set the Text Wrapping. Right click on the chart on choose Wrap Text from
the pop-up menu. Select the desired text wrapping style.

EfUat-ThoNCUs, Sem-nunc-gravidaustg _ s . It e -
) i L ave as Template... |

ra,-mattis-non, imperdistvitae,tellus.-5 = > P lin-

id-felis.Vivamus-sollicitudin-metus-ege ﬁ‘ Edit Data 4

3-0 Botation

L.

stigue-senectus-et-netus-et-malesuada

m

FIA :_ to :'_'C"“_.

resque-faucibus -Ut-accumsan-ultricies-
m-lectus-non-cdio.-

iprings Elementary Schools

Wrap Text L

e Bl [E 7 T
=
fn
=1
I
[=1]
=

Format Chart Area...

m Caroline Street Elementprsfokbonl |
-

hd
= Divizion Street Elementa Qv I_Tf
]

= Dorothy Nolan Elementz

Chart Area -

Fill  Qutline
n (Geyser Road Elementary

n Greenfield Elementary Schoaol

= Lake Avenue Elementary School
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6. More Layout Options - Right click on the chart image, hover the mouse arrow over Wrap Text

and select More Layout Options — you can use this dialog box to set the chart image’s distance

from text (see the following images).

Ta FaTagrapm Ta

g 1 2 3 4 5
MWaecenas-glacerat,-nisl-at-consequat-rhoncus,-sem-nunc-gravida-justo, -quis-eleifend-arcu
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